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INTRODUCTION TO THE SRM AGENT

The Sun StorageTek Business Analytics SRM Agent provides optimized disk scanning
based upon disk layout.

Note: With the acquisition of StorageTek, Sun Microsystems has re-branded and re-
named Global Storage Manager (GSM) as Sun StorageTek Analytics, a member of the
Enterprise Storage Manager portfolio of software solutions. The functionality of Business
Analytics is identical to GSM, only the name has changed.

Sun StorageTek Business Analytics 5.0 SP1 provides three agent installation CDs for the
supported platforms: Windows Local Manager, Solaris Local Manager, UNIX Agents (HP-
UX and IBM AIX). To upgrade an existing SRM Agent, uninstall the previously installed

SRM Agent before you install the current Sun StorageTek Business Analytics SRM Agent.

Notes: Be sure to backup the SRM config_srm.xml file, the config_srm.xsd file, and the
srmAgentPubCache.xml file before you upgrade the SRM Agent. The
srmAgentPubCache.xml file is located where specified in the config_srm.xml file. The
uninstallation of the SRM Agent on Solaris or other UNIX servers does not delete the
srmAgentPubCache.xml file and older versions of the srmAgentPubCache.xml file are not
compatible with the SRM Agent currently supplied with Sun StorageTek Business
Analytics.

The following notes apply to installing and configuring the SRM Agent:

e Refer to the Sun StorageTek Business Analytics Support Matrix to confirm the server
hardware/software configuration is supported.

« Consult the Sun StorageTek Business Analytics Agent Features Quick Facts Sheet for
a summary of the features supported by a particular SRM agent, which may vary
depending on data collection access method, platform or software components
present.

e Requires the Host Agent.

* Allows optional scanning of network-mounted file-systems.

e Supports a user-definable scan schedule.

e Base behavior is controlled by storability.ini.

* Typical filtering rules can be configured using the Management Console’s SRM Agent
Configuration menu.

e Other complex filtering rules can be manually configured in the SRM Configuration
File (config_srm.xml).

e Transform feature provides user-definable rules to facilitate user accounting.

* The SRM Agent provides support for specific file types (e.g., email archives) that
affect the agent’s configuration and reports.

« Agent auto registration is not supported for certain installation types (e.g., Self
Extracting Agent Installation).

* Only change settings in the config_srm.xsd (schema) file if instructed to do so by
your support representative.

* The Remote Share Configuration Tool (RSCT) may be used to facilitate configuring
remote shares in the config_srm.xml file. Refer to the Installation Manual to obtain
additional information on this tool.
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SOLARIS INSTALLATION

Effective with Sun StorageTek Business Analytics Release 5.1, all Solaris installation
packages contain the prefix, SUNWbizan, within their package names. These names
appear in the informational status text that is displayed when you install or uninstall a
Business Analytics agent.

The Solaris Agent Installation CD provides an installation script (setup). The installation
script (setup) can be used to:

« View a list of the available agents, depending on the server platform, that you can
choose to install or upgrade.

« Perform agent upgrade for existing agent packages.

e Uninstall (setup -u) a previously installed agent package.

The installation script will validate that you have logged in as root, which is the required
user permission to perform an agent installation. It also validates that the system is
running a supported Operating System for an agent that you select for installation or
upgrading.

AUTOMATIC AND STATIC AGENT REGISTRATION

Automatic agent registration is a configuration option for agent data collection. In the
storability.ini file, automatic agent registration is configured as follows:

* Local Manager - Specify the IP address or host name of the Local Manager to be
contacted to activate agent registration.

* Local Manager Registration Port - Specifies the TCP port number used by the
Local Manager for agent auto registration. The default port number is 17146.

* Enable Auto Registration - Turns agent auto registration on (default) or off.

To register the SRM Agent statically, proceed as follows:
* Enter false in the Enable Auto Registration field.
+ Modify the Routing Agent static agent configuration to include an entry (port
number|<agent IP address/name>)
+ Restart the Routing Agent
+ Restart the companion Central Manager agents

SRM AGENT MATRIX

Feature Description

Operating Systems

Windows « InstallShield and Self-Extracting Agent Install supported

« Silent Installation supported for both InstallShield and Self-
Extracting Agent Installation

e Required Server Access: Administrator privileges

Solaris + Installation script
» Required Server Access: root access

AIX  “Tar/install.sh” installation
« Required Server Access: root access

HP-UX  Tar/install.sh” installation
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+ Required Server Access: root access
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Feature Description

Red Hat Linux

Tar/install.sh” installation
Required Server Access: root access

Configuration
Parameters

storability.ini file * Local Manager - Specifies the IP address or host name of the
Local Manager to contact for agent auto registration. The
default value is local host (meaning the Local Manager and
SRM Agent are installed on the same server).

* Local Manager Registration Port - Specifies the TCP port
number used by the Local Manager for agent auto registration.
The default port number is 17146.

* Enable Auto Registration - Turn agent auto registration on
(default) or off.

* Location of xml schema file - Directory/folder where the
SRM Agent XSD schema file is located.

* Location of xml input file - Directory/folder where the SRM
Agent XML input file (config_srm.xml) is located.

config_srm.xml file The config_srm.xml file largely controls the behavior of the SRM
Agent. The Sun StorageTek Business Analytics administrator can
use the Management Console’s SRM Agent Configuration menus
to create and save the SRM Agent Configurations for their
environment. These menus allow the agent’s scan schedule, basic
filters, and some advanced settings in a specified config_srm.xml
file to be configured and saved.

Refer to the Administration chapter for additional information on
the SRM Agent Configuration menus in the Management
Console.

Table 1 - SRM Agent Matrix

CONFIGURATION METHODS

The Sun StorageTek Business Analytics administrator can use an XML editor to manually
configure the scan schedule, filters, and advanced options that control the behavior of
the Sun StorageTek Business Analytics SRM Agent. These configuration settings are
stored in the SRM Agent configuration file (config_srm.xml).

To greatly simplify configuring the SRM Agent, the SRM Agent Configuration window in
the Management Console provides the capability to create, modify, and save
configuration parameters for a SRM Agent installed on a Windows or UNIX platform.

Using the SRM Agent Configuration window, the Sun StorageTek Business Analytics
administrator can perform the following configuration functions:

« Specify loading a file for a Windows or UNIX platform
» Choose to load a default SRM Agent Configuration or specify the location of the
desired file.

e Specify the frequency (hourly, daily, weekly, and monthly) and any related
frequency options (e.g., hourly, every four hours).
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e Specify pre-scan and post-scan filters.
« Specify Advanced Settings (e.g., enable remote file system scan).

Using SRM Agent Configuration, the Sun StorageTek Business Analytics administrator
can set up filters, such as to identify the largest files, the largest old files, and the
general distribution of storage utilization by file type. The SRM Agent Configuration may
include new filters and related reports for:

* Email Archives - Provides filters to report detailed information about the size and
location of email archives. Default filters are provided for Outlook users’ .ost and .pst
files as well as for Lotus Notes users’ .nsf and .nst files.

* Unauthorized Files - Provides filters that help to limit the storage of particular file
types (.mp3, .wav, .avi) on corporate networks.

* Largest Directory Consumers - Provides the SRM Agent Configuration filters that
can be used to identify the directories that utilized the most disk space.

* Nth level Directories - Provides the capability to report on directories at various
levels of the hierarchy under filesystems.

Refer to the Administration chapter for instructions on the use of the Management
Console’s SRM Agent Configuration functionality. The file-specific reports are
described in the Sun StorageTek Business Analytics Management Console User’s Guide.

SRM AGENT CONFIGURATION FILE

This section describes configuration settings related to the SRM Agent Configuration File
(config_srm.xml).

Important Note: This section is only intended for customers who need to set up filters
in the configuration file beyond what can be done using the Management Console’s SRM
Agent Configuration menus, as described in the Administration chapter.

At the highest level, the configuration file is divided into three (3) sections:

* Configuration - This is the optional section containing filter definitions and
declarations.

* Agent Level Configuration - This is a mandatory section containing scan
configurations like schedules, scan-time filter configurations, and so forth.

* Table Level Configuration - This is a mandatory section, which involves section
configuration options for output tables supported by the SRM Agent.

FILTER SECTION

This section describes the basic functionality of filters used in the SRM Agent. A filter has
match criteria and an action to be performed, if the match criteria evaluates
successfully. Each row of file detail information will consume 4KB RAM.

The match criteria can be specified for different file system objects:
e File system

e Directory on the file system

« File on the file system

Page 8 SRM Agent Installation Guide



The match criteria involve comparing the attribute of the file system object to the some
value. For example, match all files whose size (size is one of the attributes of the file
system object) is more than or equal to XXMB. The match criteria are specified through
the XML configuration file installed during the SRM Agent installation.

Upon successful match, SRM Agent performs a certain action. There are three pre-
defined actions:

¢ Include - Means consider the file system object (matched by the filter criteria) for
further processing (e.g. if files match certain criterion of file_size > 100 MB, report
them in largest files table).

* Exclude - Means do not consider these file system objects (matched by the filter
criteria) for further processing (e.g. if the dir matches criterion of dir_name contains
“administrator”, do not scan further inside the dir).

* Transform - Means change the attribute value of the file system object (matched by
the filter criteria) to a given value, before further processing (e.g. change the owner
of any file under directory matching criterion dir_name contains “*george*” to
“finance department”).

The SRM Agent scans the file systems, processes the data, and finally publishes the
data. Some examples of setting the scan time filter:
e Skip a file system

e Skip a directory on a file system

An example of a processing time filter is to skip a file while calculating usage factors (but
that file will be considered for other type of processing like type distribution etc.).

Some examples of a publish time filter:
« Do not report users with less than X MB space occupied on a file system

e Do not report users, which have "ADMIN” in their username.

All the filters that are set finally affect the data being published by the SRM Agent.

CONFIGURATION LEVELS

The configuration file is divided into three levels:

» Filter Configurations
« Agent Level Configurations
e Table Level Configurations

The sequence of the configuration levels must be the same as specified above.
If the configuration parameters are not specified in the XML file, the default values are
used.

The Filter Level Configurations consists of filter definitions and declarations. The
sequences of entries in the configuration file are as follows:
* The main tag used is <filter_config>.

e There must be at least one (1) <filter_def> tag inside <filter_config> tag.
e Every filter definition must be given a unique name.

« A filter definition tag <filter_def> contains a <filter_object> tag that specifies which
file system object this filter applies to (i.e. the “match criteria”.)

e There must be exactly one <filter_object> tag inside <filter_def> tag.
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A sample filter definition is as follows:

<filter def name="temp data filter 1">
<filter object attribute="path" operator="eq"
expandEnv="true">$TEMPS</filter object
>
</filter def>

The following table explains these variables.

Attribute Name Description

name="temp_data_filter_1" Name specified for the filter definition.
Name can be user-dependent.

attribute="path” File system objects attribute to match.

operator="eq” Operator to be used while matching the
attribute.

%Temp% The pattern to be matched against given

attributes value. In this case, it is a
System Environment variable.

The following attributes and the corresponding operators can be used:

Attribute Supported Operator

Path eqg (Equal operator)

wildcardeqg (Wild card operator)

regexeq (Regular Expression operator — follows
Perl Compatible Regular Expressions)

Owner eq
wildcardeq
regexeq

Size eq

Neq (Not Equal to)

It (Lesser than)

Ilteq (Lesser than Equal To)

gt (Greater than)
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| gteqg (Greater than equal to)
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Attribute Supported Operator

access_time eq

neq

It

Iteqg

gt

gteg

modification_time eq

neq

It

Iteq

gt

gte

creation_time eq

neq

It

Iteqg

gt

gteq

Note:
The attributes and the operators are case sensitive. They should be provided in lower
case letters.

REMOTE FILE SYSTEM SCAN EXCLUSION FILTERS

If you want to skip a folder on a remote file system, a sample filter would be:
<filter def name="remotefsskip">
<filter object attribute="path" operator="wildcardeq"
caseSensitive="false">\\192.168.100.100\folder</filter object>
</filter def>

and in the Agent or tables section use:

<filter name="remotefsskip" action="exclude"/>

Note: When the SRM Agent is installed, it is registered as a service, but doesn't start
scanning. It waits for the user to configure the XML file and then starts scanning when it
is started.

AGENT LEVEL CONFIGURATION

The Agent Level configuration specifies the following:

e Scan schedule

e Scan Configuration

e Publisher Configuration

¢ Remote Command Configuration

SCAN SCHEDULE

The scan schedule configuration section contains the periodic scan specification for the
SRM Agent. The agent is configured to scan the file system based upon the scheduling
parameters passed in the configuration file.
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The sequences of entries in the configuration file are as follows:
« The main tag used is <agent_config>.

« The <schedule> tag is used to specify the schedule for the scanning process
e The <schedule> tag can contain one or more instances of the <scan> tag.

Sample entries are listed as follows:

<schedule disablePeriodicScans="false”
disableScanOnAgentStart="false”>
<scan type="exhaustive”> 1 2 * * 1</scan>

</schedule>

Attribute Name Description

disablePeriodicScans="false"” If ‘false’ then the SRM Agent periodic
scheduler is enabled otherwise vice versa

disableScanOnAgentStart="false” If ‘false’ then it means the Agent will
automatically scan the host once when the
service/daemon is started and resumes
normal schedule. If' ‘true’ then the agent
will not start the scan on the start up.

Type='exhaustive” Must be always ‘exhaustive’

Value (1 2 * * 1) This is the crontab value passed to the
attribute

The crontab format is briefly explained as follows:

« There are five elements in the value.

e 1°t element: Minute of the hour. Allowed values: 0 to 59

e 2" element: Hour of the day: Allowed values: 0 to 23

e 3" element: Day of the month: Allowed values: 1 to 31

e 4™ element: Month of the year: Allowed values: 1 to 12 (no month names allowed)

* 5™ element: Day of the week: Allowed values 0 (Sunday) to 6 (Saturday)

« If the value is greater than the allowed maximum value for an element, the current
element is “rolled over” and the “extra” or the “difference” is carried over to the next
element. If all values are to be specified for an element, use *.

SCAN CONFIGURATIONS

The scan configuration specifies the following information:

« Filter Application - Specifies which filters defined earlier in the <filter_config> have
to be used at scan time.

« Remote file system configuration - Specifies which remote file system to scan.

¢ Multithreading scan options - Specifies the level of multi-threading for scanning
local and remote file systems

Scan Configuration has an option to specify how to handle the compressed NTFS files. A
sample entry is as follows:

<scan_config handleCompressedData="true”>

</scan_config>
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Attribute Name Description

handleCompressedData="true” If ‘true’ (default), the compressed file size
is considered for calculations for all
compressed files on NTFS file system (and
not the actual size, which could be larger
than compressed file size).

handleCompressedData="false” If ‘false’, the actual file size is used for
calculations for all compressed files on
NTFS file system (and not the compressed
file size)

For uncompressed files, the actual file size is used.

FILTER APPLICATION SECTION

The <Filters> section refers to one or more filters defined previously in the
<filter_config> section.

There can be one or more <filter> tags inside <filters>. Each filter refers to a
previously defined filter definition by name and specifies the action to be taken if the
filter matches successfully.

A sample entry is listed as follows:

<filters>
<filter name="orphan user data 3"
action=" transform ">%Computername%\administrator
</filter>
</filters>
Attribute Name Description
name ="orphan_user_data_3" The filter name already defined

in the xml file.

action="transform"

action="transform">%Computername® \administrator | Filter action value (if this
‘transform’ filter matches, use
this owner ‘administrator’
instead of the existing owner of
the file system object.

REMOTE FILE SYSTEM SCAN CONFIGURATION

For Windows, perform the following steps to configure and use the remote file system
scan capabilities of the SRM Agent:

e As a system administrator, set up security to enable the SRM Agent to access the
network share (Windows).

* Define the remote file system configuration settings for your environment (see also
the following Remote File System Configuration section).

SET UP SYSTEM SECURITY
The following general security guidelines must be followed:
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e Only ‘auth_userName’ must have read permissions on the remote machine to read
the share specified in the ‘share_name’ setting.

e The'‘'imp_user’ need not have access permissions on the remote machine to be
scanned by the SRM Agent.

e The 'imp_user’ must be manually registered in Windows Local Security policy to
possess “Log On as Service Rights” privileges on the server running the SRM Agent.

e If the impersonating user is not an administrator on the computer that is running the
scan, the permissions for the C:\Program Files\Storability\GSM\Agents\Storability
SRM Agent (or where ever the SRM agent is running from) need to be updated so
that the impersonating user had read-write permissions to the directory and the files
in it. Otherwise, some of the possible error messages regarding impersonating user
will not be written to the Message log.

WINDOWS SECURITY — ADD USER

The following steps summarize adding a user on a Windows 2000 computer.

1. Log on to the Windows system using a local/domain administrative user account.

2. Select Start-> Settings ->Control Panel-> Users and Passwords.

3. Click the Advanced tab. In the Advanced User Management section, click
Advanced.

4. Click the Users folder. The current users are displayed in the right pane.

5. On the Action menu, click New User.

6. In the User Name box, type the user name and the password (the password is case-
sensitive) in the Password and Confirm Password boxes.

7. Click to clear the User must change password at next logon check box. Click
Create.

LOGON AS SERVICE USER

The Windows user to be configured as the impersonating user must be assigned the

security right, “Logon as service user”, defined under Local Security Settings. A sample
procedure follows.

1. Locate secpol.msc on your computer. The following example assumes you located
the c:\C:\WINNT\SYSTEM32 folder.

2. Open a DOS command window and change launch secpol.msc to open the Local
Security Settings window. For example, type:

C:\WINNT\SYSTEM32\secpol.msc /s

3. Expand Local Policies and click User Rights Assignment.
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Figure 1 - Local Security Settings

e

Click the Log on as a service icon and the Local Security Policy Setting window
opens.

Click Add to open the Select Users or Groups window.

Locate and select (highlight) the user you added and click Add.

Click OK to return to the Local Security Policy Setting window.

Click OK to return to the Local Security Settings window.

Close the Local Security Settings window.

OONOWU

PASSWORD ENCRYPTION

The password stored in the SRM agent configuration must be encrypted. Use the
Storability-supplied inicrypt utility to encrypt the user’s password. On Windows servers,
the default location is <drive>:\Program Files\Storability\GSM\Storability Local Manager
Utilities. On Solaris, the default location is /opt/storability/utilities. Record the encrypted
password for reference when you set up the SRM Agent’s configuration file.
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CHWWINNT  system 32 cnd.exe

Microsoft Windows 28A [Uersion H.88_21951
CC> Copyright 1985-20AA Microsoft Corp.

C:~>cd temp

CistempXinicrypt password
WFiUZF 1 1CK2ZBhUSAs 45 vw==

Co~tempX

Figure 2 - Encrypting a Password

Note: The Management Console’s SRM Agent Configuration option can be used to define
an impersonating user. However, the password that is written when you save the
configuration is not encrypted (plain text). Therefore, this password should be replaced
with an encrypted password before the SRM agent configuration file is used.

REMOTE SCANNING A WINDOWS SHARE

The remote file system scanning section of the configuration file (config_srm.xml) can
be only used on a Windows-based SRM Agent. This functionality is NOT available on
non-Windows SRM Agents.

Note: For the SRM Agent to report all the information about a file/directory, the userID
used to run the agent should have the following (effective) permissions on the directory
or the file:

» Traverse Folder

« List Folder

« Read Attributes

+ Read Extended Attributes
« Read Permissions

<remote_filesystemns enableRemoteFiican="trus"x»
<imp_userr
{imp_domain>domain;hame<fimp_domain>
<imp USErnamnexsrm</imp_ USernamneix
Linp passwordreTPAdDAnPAHT=</inp passwords
</imp user>

The tags are briefly described as follows:

* remote_filesystems enableRemoteFSScan - This tag is used to enable or disable
remote filesystem scans. The possible values for this tag are listed as follows:

<remote_filesystems enableRemoteFSScan="true">
Or:
<remote_filesystems enableRemoteFSScan="false">

SRM Agent Installation Guide Page 17



* imp_user- This tag is used to group and indicate that the encapsulated entries are
for the impersonating user information. The impersonating user information is used
by the SRM Agent for impersonating itself as a logged in user on the local machine
while connecting to the remote share.

* imp_domain- This tag specifies the Windows Domain that has the User ID indicated
by the imp_username tag. This configuration setting may contain the computer
name - this helps when the machine is not in a domain, or alternatively, the domain
name (where the user ID exists) can also be supplied.

* imp_username- This tag pair encapsulates the user name of the user to
impersonate. The SRM Agent tries to log in as this user name on the local system
before attempting the remote file system scan.

* imp_password- This tag indicates the encrypted password, which is obtained by
supplying the password to the inicrypt utility, as previously described.

* filesystem_def- This tag pair encapsulates the share definition and the user Id
information that the SRM Agent will try to use to connect to the remote file system.

* share_name- This tag indicates the path to the share in UNC format. The machine
name or its IP address (used if the machine is not in a domain) and the share name
to scan are specified. Some examples follow.

<share name>\\MACHINE NAME\shared folder</share name>
or:
<share name>\\IP ADDRESS\shared folder</share name>

* auth_username - This tag encapsulates the User ID that the SRM Agent uses for
connecting to the remote file system or remote share. The User ID specified here is
typically a local user on the remote machine where the remote file system resides,
having access to the share. However, if the share name has the machine name
specified in the share_name tag, the User ID can be a Windows domain user who
has access rights to the remote share.

For example, if the remote machine doesn’t belong to a Windows domain and the
local user name is abc, <auth_username> would just be:

<auth username>abc</auth username>

If the remote machine belonged to a domain, DOM, and the user name is xyz, the
<auth_username> would be:

<auth username>DOM\xyz</auth username>

* auth_password- This tag specifies the authentication password used by the SRM
Agent to connect to the remote share. Again, it is in an encrypted form, using the
inicrypt utility.
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EXAMPLES
Assume that:

The SRM Agent is running on MYMACHINE and that it's not in any Windows
domain.

john is a local system user on MYMACHINE.

The remote share is \\192.168.200.4\storability and it is not in the Windows
domain either.

Scott has access to \\192.168.200.4\storability.

The config_srm.xml may be set up as follows:

<remote filesystems enableRemoteFSScan="true'>
<imp user>

<imp domain>MYMACHINE</imp domain>

<imp username>john</imp username>

<imp password>1+6TOCITbM4=</imp password>
</imp user>

<filesystem def>

<share name>\\192.168.200.4\storability</share name>
<auth userName>Scott</auth userName>

<auth password>gg3o0B5JXgas=</auth password>
</filesystem def>

</remote filesystems>

Assume that:

e« The SRM Agent is running on MYMACHINE and its in Windows domain is UTOPIA.
e john is a domain user in UTOPIA.

« The Remote share is \\DOMSHARE\storability and it’s in the domain UTOPIA.

e john has access to \\DOMSHARE\storability.

The config_srm.xml may be set up as follows:

<remote filesystems enableRemoteFSScan="true">
<imp user>

<imp domain>MYMACHINE</imp domain>

<imp username>john</imp username>

<imp password>1+6TOCITbM4=</imp password>
</imp user>

<filesystem def>

<share name>\\DOMSHARE\storability</share name>
<auth userName>john</auth userName>

<auth password>1+6TOCITbM4=</auth password>
</filesystem def>

</remote filesystems>

REMOTE SCANNING THE NFS MOUNT ON SOLARIS
The section of the configuration file that pertains to remote file system scanning appears
below. You must manually add this tag to your config_srm.xml file.

l

<remote_filesystems-enableEemoteF S Scan="true"- =4

l
1
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file://192.168.200.4/storability

This tag is briefly described as follows:

* remote_filesystems enableRemoteFSScan - This tag is used to enable or disable
the remote file system scan capability. Possible values for this tag are listed as
follows:

<remote_filesystems enableRemoteFSScan="true">
or:

<remote_filesystems enableRemoteFSScan="false">

COMMON OPTIONS
The following configuration options are applicable to both "Remote scan (Windows)” and
“"Remote Mount scan (NFS)".

* multi_threading_model - This tag dictates the number of PPUs (Parallel
Processing Units) that the SRM Agent spawns to scan the file systems.

*» forRemoteFilesystems - Is specified as either "SEQUENTIAL" or
“PER_FILESYSTEM” to scan file system after file system or to start the scan of all
remote file systems at once, respectively. The SEQUENTIAL configuration setting
optimizes the use of system resources but takes longer to complete the scan. The
PER_FILESYTEM setting can optimize scan performance at the risk of consuming a
high level of system resources if many file systems are involved.

MULTI-THREADING OPTIONS
The multi-threading tag is listed as follows:

<multi threading model forLocalFilesystems="PER FILESYSTEM"
forRemoteFilesystems="PER FILESYSTEM" maxThreadLimit="3"/>

For Local Filesystems (forLocalFilesystems), the valid values are described as follows:

e "SEQUENTIAL" - In this mode, the SRM Agent will create one thread for scanning all
local filesystems.

* “PER_DISK" - In this mode, the SRM Agent will create one thread per disk for
scanning local filesystems. This is supported on a Windows server only.

¢ "“PER_FILESYSTEM" - In this mode, the SRM Agent will create one thread per
filesystem for scanning local filesystems.

For Remote Filesystems (forRemoteFilesystems), the valid values are described as
follows:

e "SEQUENTIAL" - In this mode, the SRM Agent will create one thread for scanning
all remote filesystems.

e “PER_FILESYSTEM" - In this mode, the SRM Agent will create one thread per
filesystem for scanning remote filesystems.

The Max Thread Limit (maxThreadLimit ) parameter specifies the maximum number of
threads that the SRM Agent can create while scanning local and remote filesystems
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combined. The default value of "maxThreadLimit" is 3, and this value can be extended to
a maximum of 10.

Note: Any multi-threading option other than those described above is considered as
"invalid". In this case, the SRM Agent will discard the invalid value and will revert to the
default value of the above attributes.

TRANSFORM FILTERS

Transform filters allow you to transform the owner of a directory for reporting purposes.
You define the Transform filters in the SRM Agent Configuration file, which is located in
the SRM Agent folder on Windows or in the /install_directory/storability/etc directory
(e.g., /opt/storability/etc) on Solaris. The Transform filters are not designed to change
system directory/file permissions.

TRANSFORM DIRECTORY OWNER RECURSIVELY

There are two operators that allow you to transform the owner of all files under a
directory as well as those under its subdirectories: the “wildcardeq” operator and the
regexeq operator.

USING THE WILDCARDEQ OPERATOR
A sample configuration that uses the “wildcardeq” operator follows.

<filter config>

<!-- Filters get defined here to specify the path needed for the transform filter
-—>

<!—For transforming owner of files under sub-directories of dnorton directory-->
<filter def name="dnorton filterR">

<filter object attribute="path"
operator="wildcardeq">/users/dnorton/*</filter object>

</filter def>

<!—For transforming owner of files under dnorton directory-->

<filter def name="dnorton filter">
<filter object attribute="path" operator="eq">/users/dnorton</filter object>
</filter def>

<filter config>

<scan config handleCompressedData="true'">
<filters>

<!-- we use the filter here as a transform filter, where all the files defined in
dnorton filter will be owned by the user of dnorton. It can also be changed to any
other existing user. -->

<filter name="dnorton filterR" action="transform">dnorton</filter>
<filter name="dnorton filter" action="transform">dnorton</filter>

</filters>

USING THE REGEXEQ OPERATOR
A sample configuration that uses the “regexeq” operator follows.

<filter config>

<!-- Filters get defined here to specify the path needed for the transform filter
-——>

<filter def name="dnorton filterR">
<filter object attribute="path"
operator="regexeq">/users/dnorton/[.]*</filter object>
</filter def>
<filter def name="dnorton filter">
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<filter object attribute="path" operator="eq">/users/dnorton</filter object>
</filter def>

<filter config>

<scan config handleCompressedData="true">

<filters>

<!-—- we use the filter here as a transform filter, where all the files defined in
dnorton filter will be owned by the user of dnorton. It can also be changed to any
other existing user. -->

<filter name="dnorton filterR" action="transform">dnorton</filter>
<filter name="dnorton filter" action="transform">dnorton</filter>

</filters>
TRANSFORM DIRECTORY OWNER RECURSIVELY WITH EXCEPTION
The Transform feature also allows you to transform the owner of all files under a
directory as well as the files under the subdirectories except for one directory, such as
subDirl.

USING THE WILDCARDEQ OPERATOR

A sample configuration that uses the “wildcardeq” operator to transform the owner of all
files under the dnorton directory as well as the files under the subdirectories except for
one directory, subDirl, follows.

<filter config>

<!-- Filters get defined here to specify the path needed for the transform filter
-—>

<filter def name="dnorton filterR">
<filter object attribute="path"
operator="wildcardeq">/users/dnorton/*</filter object>
</filter def>
<filter def name="dnorton filter">
<filter object attribute="path" operator="eq">/users/dnorton</filter object>
</filter def>

<filter def name="subDirl filter">
<filter object attribute="path" operator="eq">/users/dnorton/subDirl</filter object>
</filter def>

<filter config>

<scan config handleCompressedData="true'">
<filters>

<!-- we use the filter here as a transform filter, where all the files defined in
dnorton filter will be owned by the user of dnorton. It can also be changed to any
other existing user. Order is important, transform filter for subDirl must come prior
to dnorton-->

<filter name="subDirl filter" action="transform">subDiruser</filter>

<filter name="dnorton filterR" action="transform">dnorton</filter>
<filter name="dnorton filter" action="transform'">dnorton</filter>

</filters>
USING THE REGEXEQ OPERATOR
A sample configuration that uses the “regexeq” operator to transform the owner of all
files under the dnorton directory as well as the files under the subdirectories except for
one directory, subDirl, follows.

<filter config>
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<!-- Filters get defined here to specify the path needed for the transform filter
-—>

<filter def name="dnorton filter">
<filter object attribute="path"
operator="regexeq">/users/dnorton/[.]*</filter object>
</filter def>
<filter def name="dnorton filter">
<filter object attribute="path" operator="eq">/users/dnorton</filter object>
</filter def>

<filter def name="subDirl filter">
<filter object attribute="path"
operator="eq">/users/dnorton/subDirl</filter object>
</filter def>

<filter config>

<scan config handleCompressedData="true">
<filters>

<!-- we use the filter here as a transform filter, where all the files
defined in dnorton filter will be owned by the user of dnorton. It can also be
changed to any other existing user. Order is important, transform filter for
subDirl must come prior to dnorton-->

<filter name="subDirl filter" action="transform">subDiruser</filter>
<filter name="dnorton filterR" action="transform">dnorton</filter>

<filter name="dnorton filter" action="transform">dnorton</filter>

</filters>
TRANSFORM DIRECTORY OWNER NON-RECURSIVELY
The Transform feature may also be used to transform the owner of directory non-
recursively. You set up the non-recursive transform of directory ownership as shown
below.

<filter config>

<!-- Filters get defined here to specify the path needed for the transform filter
-—>

<filter def name="dnorton filter">
<filter object attribute="path" operator="eq">/users/dnorton/</filter object>
</filter def>

<filter config>

<scan config handleCompressedData="true">

<filters>

<!-- we use the filter here as a transform filter, where all the files defined in
dnorton filter will be owned by the user of dnorton. It can also be changed to any
other existing user. -->

<filter name="dnorton filter" action="transform">dnorton</filter>

</filters>
SAMPLE TRANSFORM FILTER SETTINGS FOR WINDOWS
Sample Transform filter settings for use on a Windows server appear below.

<filter def name="tl r"> <!--filter for transforming owner of subdirectories-->
<filter object attribute="path" operator="wildcardeq" expandEnv="true">C:\Program
Files\*</filter_ object>

</filter def>
<filter def name="tl1l"> <!-- while specifying directory name, don't append "\" at the
end -->

<filter object attribute="path" operator="eq" expandEnv="true">C:\Program

Files</filter object>

</filter def>
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<scan_config handleCompressedData="true">
<filters>
<filter name="sys data filter 1" action="exclude"/>
<filter name="sys data_ filter 2" action="exclude"/>

<filter name="tl" action="transform">all</filter>
<filter name="tl r" action="transform">all</filter>
</filters>

SAMPLE TRANSFORM FILTER SETTINGS FOR SOLARIS
Sample Transform filter settings for use on a Solaris server appear below.

<filter def name="tmp dir r'">
<filter object attribute="path" operator="wildcardeq">/tmp/*</filter object>
</filter def>
<filter def name="tmp dir">
<filter object attribute="path" operator="eq">/tmp</filter object>
</filter def>

<filter name="sys data filter 1" action="exclude"/>
<filter name="sys data filter 2" action="exclude"/>
<filter name="sys data filter 3" action="exclude"/>
<filter name="root" action="exclude'"/>
<filter name="tmp dir" action="transform">mandar</filter>
<filter name="tmp dir r" action="transform'">mandar</filter>
</filters>

VERIFYING TRANSFORM FILTERS
To verify Transform filters are working properly, use the Agent Diagnostic Tool
(gsmdiag.exe).

* Collect the gsm_srm_largest_files (or gsm_srm_largest_old_files) table and
examine the owner column data.

* Collect the gsm_srm_user table and examine the srm_user_id and
srm_user_name columns’ data

PUBLISHER CONFIGURATION SECTION

This section sets the options for the publisher behavior.

Attribute Name Description
publishDataPerFilesystemScanUpdate<publish | If ‘true’ (default), as soon as a scan for
er_config a file system finishes, the data in SRM
publishDataPerFilesystemScanUpdate="true” Agent tables is immediately updated.
enableDiskCache="true"/> ="true” If ‘false’, SRM Agent waits for the entire

scan to complete (for all file systems) to
update data.

publisher_config enableDiskCache ="true” If ‘false’ (default), SRM Agent will not
update/create local disk cache. If ‘true’,
whenever table data is updated, it is
synched with a local disk cache (so that
when the SRM Agent is restarted, it can
still serve last scan data.

REMOTE COMMAND CONFIGURATION SECTION

This section contains a list of users and their encrypted password (<auth_user>
elements), which will be allowed to use the remote commands (one of the username-
password pair from this list in the configuration must be specified as table request
parameters while sending remote commands to the SRM Agent). Optionally, the user
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can specify which OS group should be allowed to use remote commands.

entry follows:

<remote command config>

<auth user>

<auth username>srmAdminl</auth userName>

<auth pass>OKQWJIEOWQES1==

</auth_user>

</auth password>

<os_auth group>GSM SRMAdmin</os auth group>

</remote command config>

A sample

Tag Name

Description

<auth_username>srmAdminl</auth_userNa

me>

UserName.

<auth_pass>0OKQWIE9WQE91==
</auth_password>

Encrypted Password.

<os_auth_group>GSM
SRMAdmin</os_auth_group>

password along with the
command).

OS users, which are members of this OS
group will be allowed to send remote
commands (if they specify their valid

remote

TABLE LEVEL CONFIGURATION

The filters applied at publishing time are called Table Filters. Hence table filters are
applied after scan filters. Some examples of table filters are listed as follows:

« Skip temporary directories when reporting data for largest files.
e Do not report users with less than X MB space used on a file system.

The regexeq operator is not supported for "gsa_srm_temporary_directories" table

filters.

Filter Tag name

Filter Description

Examples

<gsa_srm_temporary_directories>

Identify certain directories on a file
system as a “temporary directory”.

Temp folders
like

Report these in C:\temp,
gsa_srm_temporary_directories c:\tmp or
table. /tmp,
/var/tmp
<gsa_srm_largest_files> & Threshold filter that skips certain Do not
<gsa_srm_largest_old_files> files or folders while reporting data | report
on largest files on file system. c:\pagefile.s

Allows, “exclude” action filters.

ys or any file
under

c:\WINNT as
largest files.
<gsa_srm_usage_factors> Skip files or directories while Skip
calculating usage pagefile.sys

Allows, “exclude” action filters.

on all drives
while
calculating
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| usage factor. |
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Filter Tag name Filter Description Examples
<gsa_srm_usage_details> Report data related to Specific File | Report all
Types based on configuration email
parameters specified in the archives
configuration file (*.pst, *.ost,
.nsf). Report
all
unauthorized
files (*.mp3,
*.mpeg,
*.avi)
<gsa_srm_type_distribution> Files of these types (ex exe, EXE) Report all
are treated case insensitive .exe and
.EXE file
tyes.

Besides these generic filters, there are few additional filters available, such as
gsa_srm_user, gsa_srm_size_distribution and gsa_srm_filesystem.

The sections below describe table filter tags in detail.

GSA_SRM_LARGEST_FILES SECTION
This section specifies the criteria for selecting “largest files” on a file system. A sample
entry is as follows:

<gsa_srm largest file rowsPerFileSystem="25"
fileSizeThreshold="5242880" />

Attribute Name Description

rowsPerFileSystem="25" Report only specified number of rows (at max) per file
system, that is, 25. The default range is zero (0) to
3000 rows.

fileSizeThreshold="5242880" Only consider files whose size (in bytes) is greater
than the specified threshold (i.e. 5242880). The
default range is zero to "9223372036854775807" or
signed int64.

GSA_SRM_LARGEST_OLD_FILES SECTION
This section specifies the criteria for “largeness” as well as “oldness” of files on a file
while selecting them for this table

A sample entry is listed as follows:

<gsa srm largest old file rowsPerFileSystem="25"
fileSizeThreshold="5242880"

fileAgeThreshold="P3M" />
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Attribute Name Description

rowsPerFileSystem="25" Report only specified number of rows (at
max) per file system (i.e. 25).

fileSizeThreshold="5242880" Only consider files whose size (in bytes) is
greater than the specified threshold (i.e.
5242880).

fileAgeThreshold="P3M" Only consider files, which are not modified

after the timestamp (scan start -
fileAgeThreshold).

GSA_SRM_USAGE_FACTORS SECTION
The element <time_spans> specifies the time span ranges for usage factor calculations.

<time spans>PT1H P1D P7D PIM P3M PlY P2Y</time spans>

Tag Name Description
<time_spans>PT1H P1D P7D P1M P3M P1Y A space-separated list of "XML
P2Y</time_ spans> duration”.

A duration has the following format:

PnYnMnDTnHNMnS

Where:
* nis an integer.

* Value must begin with P...

e Year, Month, Day are optional (at least hour or minute or second part must be
present). In that case, the value must begin with PT...

e Hour, Minute, Seconds are optional (at least year or month or day part must be
present).

The SRM Agent takes these durations and subtracts them from the scan start time to
generate a list of durations for reporting (these durations then become “buckets” in
which the files are categorized for access timestamp, creation timestamp and
modification timestamp).

GSA_SRM_TYPE_DISTRIBUTION SECTION

This section contains filtering information for type distribution. If you do not want all the
file types found on the filesystem, you can limit the file types using this element. You
can ask the agent to either exclude the given file types and report all other file types, or
only include the given file types and aggregate together all other file types under a
single "OTHER" file type.

If the attribute ignoreTypeCase is true, the agent will ignore the case when analyzing
the data. E.g. it will consider .Exe, .EXE, .exe as the same file types and report a single
row for .exe (all lower case).
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If desired, you can specify (using the fileCountPerType attribute) to report the file type
only if the number of files for this type are greater than the specified value.

Also, you can specify (using the consumedSpacePerType attribute) to report the file type
only if the space consumed by files of this file type is greater than the specified value.

If both attributes (i.e., fileCountPerType and consumedSpacePerType) are specified, the
agent will do a logical AND operation for these two criteria. If any one of these two is
specified, only that criterion will be applied.

<gsa_srm type distribution ignoreTypeCase="true”>

</gsa_ srm type distribution>

Attribute Name Description

ignoreTypeCase="true” If true (default), types (file extensions) are
treated in case insensitive manner (e.g. .Exe,
.EXE, .exe are same).

consumedSpacePerType= Optional. Report the file type only if the
number of files for this type are greater than
the specified value. The minimum value is zero
(0) and the maximum value is
9223372036854775807.

fileCountPerType= Optional. Report the file type only if the
consumed space is greater than the specified
value. The minimum value is zero (0) and the
maximum value is 9223372036854775807.

SPECIFIC FILE TYPE FILTERS
The creation of user-defined filters is a two step process:

e Define the filter in the <! Define Filters for Specific File Type Report
here -> section

* Enable the filter by adding it to the <! Define Filters for Specific File
Type Report here -> section of the SRM Agent Configuration File

Default specific file type filters are supplied for email archives and unauthorized files.
Additional user-defined, specific file type filters can be manually added to the SRM Agent
Configuration File.

<!-- Show Email Archive File Usage -->
<!-- Show Unauthorized File Usage -->
<! -- Show Graphic File Usage -->

<filter def name="Email Archives"><filter object attribute="path"
operator="wildcardeq" expandEnv="true">*.pst,*.nsf, *.ost, *.nst
</filter object></filter def><filter def

name="Unauthorized Files"><filter object attribute="path"
operator="wildcardeqg"
expandEnv="true">* .mpeqg, *.mp3, *.avi, *.mov, *.wma, *.wmv, *.aiff, *.wav
</filter object></filter def></filter config>

<gsa_srm usage details rowsPerFilter="25" fileSizeThreshold="5242880">
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<filters>

<!-- Apply Filters For Specific File Type Report Here -->

<!-- Show Email Archive Usage -->

<filter name="Email Archives" action="include" />

<!-- Show Unauthorized Files Usage —-->

<filter name="Unauthorized Files" action="include" />
</filters>

</gsa_ srm usage details>

Attribute Name Description
Filter _def name= Filter name enclosed in quotation marks.
Filter_object_attribute= Specifies the filter’s file path (may be

wild carded), whether case-sensitivity is
observed, and the filename extensions
separated by a comma.

rowsPerFilter The number of rows that will be
reported per filter, per filesystem that is
applied to this table. The default value is
"25".

fileSizeThreshold The file size threshold that
will be maintained when reporting data.
The default value is "5242880".

Email Archive Specify the file types to include such as

.pst, .ost, .nsf, .nst. The name SHOULD
NOT be modified, as it is used in the
reports. This filter is specific to the
gsa_srm_usage_details table ONLY.

Unauthorized Files Specify the file types to include such as

.mpg, .jpg, .exe. The name SHOULD
NOT be modified, as it is used in the
reports. This filter is specific to the

gsa_srm_usage_details table ONLY.

SAMPLE USER-DEFINED SPECIFIC FILE TYPE
The following example shows how you can set up the SRM Agent Configuration File to
add a user-defined report for graphic files.

1. Open the config_srm.xml file on the machine with the SRM Agent with a text editor
or .xml editor.

2. Add a new filter definition under <!-- Define Filters for Specific File Type
Report here -->. An easy way to do this is to copy one of the existing filters and
change the name and file extension list. For example:

<!-- Show Graphic File Usage -->
<filter def name="Graphic Files">
<filter object attribute="path"
operator="wildcardeqg"
caseSensitive="false">*.jpg, *.psd, *.gif, *.bmp, *.tif, *.ai, *.pdf, *.png
</filter object>
</filter def>
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3. Enable the filter by adding it to <!-- Apply Filters For Specific File Type
Report Here --> section of the .xml file (close to the end of the file). For the
example above, the entry would be:

<!-- Show Graphic Files Usage -->
<filter name="Graphic Files" action="include"/>

4. Restart the SRM Agent, to initiate a new data collection. The filesystem scanning
process can take some time. You can check the progress by opening the agent’s
Message.log. When the SRM Agent finishes scanning, it will write an entry like:

12/19/2004 15:37:12PM|INFO|0|jobManager:Scanning finished for

filesystem : C:\|srmAgent|CJob.cc|172

12/19/2004 15:37:12PM|INFO|0|Notify () method Called|srmAgent|

CResourceManager.cc|441

12/19/2004 15:37:12PM|INFO|0|jobManager:Finished job to scan

filesystems after agent was started as per config option|srmAgent|

CJobManager.cc|143

12/19/2004 15:37:12PM|INFO|0|jobManager:Next scheduled scan time is Sun

Dec 26 00:00:00 2004 |srmAgent|CJobManager.cc|186

5. Run GSMdiag.exe located in the Storability Local Manager Utilities folder.

a. In the Agent location window, enter the IP Address or network resolvable Host
Name of the Local Manager where the agent has registered itself and set the port
number to 17130.

b. Select gsa_register table and verify it shows a SRM Agent row (port 17152)
specifying it is active and registered from the particular host.

C. Click Published Objects and scroll down to select the gsa_usage_details
object.

d. Verify that the gsa_usage_details object reports data in the resource_name
column.

NTH LEVEL DIRECTORY REPORTING

The SRM Agent can report on directories at various levels of the hierarchy under
filesystems. The directory level at which data can be obtained can be configured by
modifying the config_srm.xml file. The directory data will be reported in the
gsa_srm_temporary_directories table.

How TO CONFIGURE NTH LEVEL DIRECTORY REPORTING

You can configure the SRM Agent configuration file (config_srm.xml) using the methods
that are described below to obtain Nth level directory reporting. The recursion limit is
256 directories.

OBTAINING FIRST LEVEL DIRECTORY DATA

To get the first level directory data, perform the following steps.

1. Add the following filter in the <filter_config> section.

<filter def name="temp data dirs level one">

<filter object attribute="path" operator="wildcardeqg"
caseSensitive="false">*\*</filter object>
</filter def>

2. Add the above-defined filter to the <filter> section of the
gsa_srm_temporary_directories configuration.

<filter name=" temp data dirs level one" action="include"/>
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NOTE:

First level directories are obtained by specifying the filter name as "*" on UNIX. When
Windows reports a directory called test located on c:, for example, it reports that
directory as "C:\test". In this case, we need to specify "*\*" as the filter to see the
first level directories on ALL existing drives that are going to be scanned. If

you want to see the first level directories on C:, your filter would be "C:\*".

On UNIX, however, only "*" works for directories being reported as "/etc", for instance.

OBTAINING SECOND LEVEL DIRECTORY DATA
To get the second level directory data, perform the following steps.

1. Add following filter in the <filter_config> section.

<filter def name="temp data dirs level two">
<filter object attribute="path" operator="wildcardeq"
caseSensitive="false">*\*\*</filter object>

</filter def>

2. Add above defined filter to <filter> section of gsa_srm_temporary_directories
configuration.

<filter name=" temp data dirs level two" action="include"/>

OBTAINING FIRST AND SECOND LEVEL DIRECTORY DATA
To get the first and second level directory data, perform the following steps.

1. Add the following filters in the <filter_config> section.

<filter def name="temp data dirs level one">
<filter object attribute="path" operator="wildcardeq"
caseSensitive="false">*\*</filter object>
</filter def>
<filter def name="temp data dirs level two">
<filter object attribute="path" operator="wildcardeq"
caseSensitive="false">*\*\*</filter object>

</filter_def>

2. Add the above-defined filters to the <filter> section of the
gsa_srm_temporary_directories configuration.

<filter name=" temp data dirs level one" action="include"/>
<filter name=" temp data dirs level two" action="include"/>

OBTAINING FIRST AND SECOND LEVEL SUBDIRECTORIES DATA
To get the first and second level subdirectories under a directory C:\Storability, perform
the following steps.

1. Add the following filters in the <filter_config> section.

<filter def name="temp data dirs level one">
<filter object attribute="path" operator="wildcardeq"
caseSensitive="false">C:\Storability\*</filter object>
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</filter def>
<filter def name="temp data dirs level two">
<filter object attribute="path" operator="wildcardeq"
caseSensitive="false">C:\Storability\*\*</filter object>
</filter def>

2. Add the above-defined filters to the <filter> section of the
gsa_srm_temporary_directories configuration.

<filter name=" temp data dirs level one" action="include"/>
<filter name=" temp data dirs level two" action="include"/>

OBTAINING FIRST, SECOND, AND THIRD LEVEL DIRECTORY DATA
To get the first, second, and third level directory data, perform the following steps.

1. Add the following filters in <filter_config> section

<filter def name="temp data dirs level one">
<filter object attribute="path" operator="wildcardeq"
caseSensitive="false">*\*</filter object>
</filter def>
<filter def name="temp data dirs level two">
<filter object attribute="path" operator="wildcardeq"
caseSensitive="false">*\*\*</filter object>
</filter def>
<filter def name="temp data dirs level three">
<filter object attribute="path" operator="wildcardeq"
caseSensitive="false">*\*\*\*</filter object>
</filter def>

2. Add the above-defined filters to the <filter> section of the
gsa_srm_temporary_directories configuration.

<filter name=" temp data dirs level one" action="include"/>
<filter name=" temp data dirs level two" action="include"/>
<filter name=" temp data dirs level three" action="include"/>

NTH LEVEL DIRECTORY CONFIGURATION
SUMMARY

Directories at any level can be obtained by increasing the number of wildcards “*"”
preceded by the backward slash ™\” in the filter definition. Another example is listed as
follows:

*\*\*\*\*\*,

*FNF\*F\* . C:\Storability\*\*\*\*\*

SRM AGENT OBJECTS

The following table describes the objects that the Sun StorageTek Business Analytics
SRM Agent publishes. You can use the Agent Diagnostic Tool (gsmdiag.exe) to collect
any and all of these tables. See also the Verifying SRM Agent section.

Note: The gsa_srm_usage_details object supports the new specific file (e.g., email
archive) reports. The report_name field will be populated by the matching file type
extension to the report, as defined by the SRM Agent Configuration tab. The values for
report_name are added to the report list in the File Level Details report.
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Object

Description

alerts-3_1

ip_address, port, when, application, severity, id,
description, timestamp

gsa_agent_version-2_0

ip_address, port, agent_name, version,
compile_time, managed_entities, tz_name, tz,
timestamp

gsa_cache_control-2_0

ip_address, port, table_name, cache_age,
last_update_request_length,
update_request_pending, group_name,
group_master, timestamp

gsa_parm_info

ip_address, port, object, parm_name,
value_syntax, description_required

gsa_srm_command

ip_address, nodename, host_id, command, params,
arrival_time, status, status_description, timestamp.

gsa_srm_filesystem

ip_address, nodename, host_id, filesystem_.id,
filesystem_type, filesystem_attributes, block_size,
total_capacity, used_capacity, file_count, directory
count, average_file_size, median_ file_size, user_
data_size, metadata_size, block_size overhead,
last_ scan_time, timestamp.

gsa_srm_filesystem_consumers

ip_address, nodename, host_id, filesystem_.id,
owner, consumed_blocks, consumed_space,
last_scan_time, timestamp.

gsa_srm_largest_files-2_1

ip_address, nodename, host_id, filesystem_.id, file_
name, type, owner, time, size, last_scan_time,
access_time, creation_time, timestamp.

gsa_srm_largest_old_files-2_1

ip_address, nodename, host_id, filesystem_.id, file
_hame, type, owner, time, size, last _scan_ time,
access_time, creation_time, timestamp.

gsa_srm_mount_points

ip_address, nodename, host_id, mount_point, last_
scan_time, timestamp.

gsa_srm_size_distribution

ip_address, nodename, host_id, filesystem_.id,
range_start, range_stop, file_count, average_file_
size, median_file_size, consumed_ blocks,
consumed_space, last_scan _time, timestamp.

gsa_srm_temporary_directories

ip_address, nodename, host_id, filesystem_.id,
directory_name, owner, consumed_space,
last_scan_ time, timestamp.

gsa_srm_type_distribution

ip_address, nodename, host_id, filesystem_.id, type,
file_count, consumed_blocks, consumed_space, last
_scan_time, timestamp.

gsa_srm_usage_details-2_1

ip_address, nodename, host_id, filesystem_.id,
resource_name, extension, owner, time, size,
filter_name, last_scan_time, access_time,
creation_time, timestamp

gsa_srm_usage_factors

ip_address, nodename, host_id, filesystem_.id,
factor_type, time_span_type, time_span, user
_data_factor_percentage, file_count_factor
_percentage, last_scan_time, timestamp.
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Object | Description

gsa_srm_user ip_address, nodename, host_id, srm_owner_type,
srm_user _d, srm_user_name, srm_group_id, srm_
group_name, allocated_quota, used_quota, last_
scan_time, timestamp.

Table 2 - SRM Agent Objects

LOCAL MANAGER INSTALLATION CD (INSTALL

SHIELD)

Besides the SRM Agent, the installation program (Install Shield) installs the current
version of the Host Agent if it detects a previous version exists on the system.

1. Insert the Sun StorageTek Business Analytics Windows Local Manager CD into the
CD-ROM drive.

2. Click Next on the Welcome menu to continue the installation.

3. Click Yes to accept the terms of the software license agreement.

4. Review/modify the User Name and Company Name and click Next>.

5. Select the SRM Agent under the Host heading on the screen that lists the Sun
StorageTek Business Analytics Agents for installation (and the Host Agent if not

already installed) and click Next>.

6. Click Next> to accept the default destination folder or specify a different installation
path.

7. Review the installation settings and click Next to continue.
8. If the Host Agent is already installed, specify whether or not to reinstall this agent.
9. Specify whether or not to install the new version of the Configuration Tool.

10. When the Configuration Tool is launched, click File->Edit->Smart Agent
Configuration.

11. Click the SRM Agent tab in the main window.
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12.

13.

14.

15.

16.

17.

18.

19.

20.

21.

A storability.ini

Fabric Agent [ TSM Agent [ SRM Agent [Policy Ayent [Scheduler Agent | DataAgarenator Agent | DataPolling Agent
Rauting Agent ” L5l Agent ” STRLSeries Agent ’/ Database Agent License Agent HostAgent

¥l Save Configuration Setfings  Current Parametars

Local Manager ||0ca|host |
Local Manager Fart 17145 |
ML schema file name |C:1Program FilesiStorahilitdz5MAgentsIStorability SRM Agenﬂconﬂg_srm.xsd| &
ML inputile name |C:1Program FilesiStorahilitdz5MAgents\Storability SRM Agenﬂconﬂg_srm.xml”?
Comrments
Advanced Settings Gurrent Parameters Template Farameters

Enable Auto Registration |true |

Figure 3 - SRM Agent Tab in Configuration Tool

In the Local Manager field, type the network resolvable name or IP address of the
Local Manager to contact for agent auto registration. The default value is “localhost”.

Specify the TCP port number that the Local Manager uses for agent auto registration.
The default port number is 17146.

For the XML schema file name, setting click the Folder icon and browse to the
folder where the config_srm.xsd file is installed. The default location is c:\Program
Files\Storability\Agents\Storability SRM Agent.

Select the file and click Open.

For the XML input file name setting, the Folder icon and browse to the folder
where the config_srm.xml file is installed. The default location is c:\Program
Files\Storability\Agents\Storability SRM Agent.

Select the file and click Open.

Click Advanced Settings to review/modify the “"Enable Auto Registration”
configuration setting. This configuration parameter turns agent auto registration on
(default) or off.

With the “Save Configuration Settings” check box enabled (check mark), click File-
>Save and then confirm saving the storability.ini file.

Select File->EXxit to close the Configuration Tool.

To complete the installation, view and then close the Readme file and click Finish.
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22.Work with your Sun StorageTek Business Analytics administrator to:
a. Verify the Sun StorageTek Business Analytics administrator has used the
Management Console’s SRM Agent Configuration menus to configure the
SRM Agent Configuration and downloaded/copied the SRM Agent Configuration
file to the SRM Agent folder
Or:

b. Set up the SRM Agent Configuration File (config_srm.xml) using another
method, such as an XML Editor.

23.Use the Windows Services panel to start the configured SRM Agent.

24. Proceed to the Verifying SRM Agent section.

SRM AGENT STANDALONE INSTALLSHIELD
INSTALLATION

1. Insert the Sun StorageTek Business Analytics Local Manager CD into the CD-ROM
drive. If the InstallShield-based installation program is automatically launched, close
the program.

2. Open a DOS Command Window.

3. Change directory to Win32\SrmAgentSetup.

4. Type setup.exe and press Enter. The SRM Agent Welcome screen appears. Click
Next> to continue.

5. Click Yes to accept the terms of the software license agreement.

6. Review/modify the informational User Name and Company Name and click Next>.

7. Click Next> to accept the default destination folder (i.e., <drive>:\Program
Files\Storability) or click Browse to select another destination folder. Note that the

\GSM folder will be created under the destination folder that you specify.

8. Review the settings and click Next> to continue. The Installation in progress splash
screen appears.

9. When the InstallShield Wizard Complete screen appears, click Finish. At this
point, the Storability SRM Agent is installed and running on the Windows server.

INSTALLING THE SRM AGENT ON SOLARIS

Follow the procedure outlined below to install the SRM Agent on a Solaris host server.
The installation script (setup) is supplied on the Solaris Local Manager Installation CD.
Note: The SRM Agent must be run in Administrative user privileges for full functionality.

1. Open a terminal window on the desktop of the Sun host.

2. Mount the Local Manager installation CD in your CD-ROM drive. For example:

mount —-o ro —-F hsfs /dev/dsk/c0t6d0s0 /cdrom
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3. Change directory to the mount point, such as /cdrom in this example.

4. Run the installation script to access the main agent installation main menu.

./setup
5. Select to install the SRM Agent.

6. Type zero (0) and press Enter to specify that you have finished selecting agents for
installation.

7. The informational text “The srmAgent can be controlled by remote requests. Such
requests, if enabled, must be authenticated with a username and password.”
appears.

8. Allow remote srmAgent commands with a specific user/password pair? [n] [y,n,?].
Specify y(es) to allow the SRM Agent to be managed through remote commands or
press Enter to accept the default value of not enabling this feature.

9. The informational text “Alternately, permission may be granted to members of a

specific group to issue commands to the srmAgent, by giving their own username
and password (as determined by PAM(3)).” appears.

10.Allow authentication to system accounts? [n] [y,n,?] Enter y(es) to enable this
authentication method or press Enter to not enable it.

11.Type y and press Enter to review/modify the Advanced Settings.

« Allow the agent to be restarted by Agent Monitor (default) if the agent is detected
as not running, or type n and press Enter to not use this feature.

« Specify whether (y/n) agent auto registration is enabled. This feature is enabled
by default.

« Specify the IP address or network resolvable host name of the Local Manager to
be contacted for agent auto registration. The default value is local host.

e Specify the TCP port number the Local Manager uses for agent auto registration.
The default port number is 17146.

« Read the informational text that specifies why you will want to customize the
settings in the config_srm.xml file.

« Specify whether (y/n) you want all agents on the Solaris server to be restarted
after the installation has completed.

e Specify whether (y/n)to configure the SRM Agent to run scans weekly starting at
midnight on Sunday as one of its “scan schedules”.

12. When prompted, type y and press Enter to confirm continuing the installation of the
SRM Agent.

13.The installation will complete and return you to the command line.
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14. Use the process status (ps) command to verify the SRM Agent is running before you
verify agent functionality.

Notes:

The run scripts (start/stop) for all Business Analytic agents are installed into the
/etc/init.d directory. The agent will log a message in the message log that
indicates the filesystem scanning has been completed.

INSTALLING SRM AGENT ON IBM AIX

All currently supported AIX agents are provided with both the .tgz (gzipped tar) file and
the install script. Ensure that the “srmAgent-install.sh” and srmAgent-AIX.tgz files reside
in the same location. If the Host Agent is not installed, it will be installed before the SRM
Agent is installed. If the Host Agent is installed, the installation script will stop and then
restart it.

1. Mount the UNIX Agent Installation CD. For example:

mount -v cdrfs -r /dev/cd0 /mnt # /mnt directory must exist

2. Change directory to the software installation directory. For example:
cd /mnt/Unix/AIX/5.x

3. Run the installation script:

srmAgent-install.sh
4. The installation script installs the SRM agent and returns you to the command line.

Agent Auto Registration on IBM AIX

To configure agent auto registration, you can manually add the SRM Agent to a Local
Manager Routing Agent configuration as a SUB_AGENT entry or add the required entries
to the storability.ini file. Sample storability.ini settings for the agent appear below.

GSM LM HOST = 10.192.1.56
GSM_LM PORT = 17146
GSM_ENABLE LM REGISTRATION = true

INSTALLING THE SRM AGENT ON HP-UX

The following notes apply to installing Sun StorageTek Business Analytics agents on this
platform:

* The Sun StorageTek Business Analytics Agent installation must be carried out locally
by root.

* You may mount the software media directly using the local CD-ROM drive or copy
the CD contents to some location on the server.

o # ioscan —-funC disk # Identifies cdrom device

o Sample mount command:
# pfs_mount -o xlat=unix /dev/rdsk/cXtXd0 /SD_CDROM
(where /dev/rdsk/cXtXdO is the cdrom device)
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* Depending on which filesystem extensions are recognized by the host, the location,
relative to the CD root, will be:

UNIX/HP-UX/<version> (basic ISO 9660 filesystem)
Unix/HP-UX/<version> (ISO 9660 with extensions)

« The software installation directory contains both the .tgz (gzipped tar) file and the
install script.

« To install individual agents, simply run the corresponding installation
Script, for example:

srmAgent-install.sh (ISO 9660 with extensions)

+ The agent should be started and stopped using the init scripts in the /sbin/init.d
directory.
» Use the following command to confirm which agents are running:

$ ps —-ef | grep Agent

* Refer to the READ.TXT file on the installation CD for additional information on
installing Sun StorageTek Business Analytics agents on a HP-UX server.

1. Mount the installation CD in the CD-ROM drive of the HP-UX server.
2. Change directory to the software installation directory. For example:

cd /cdrom/UNIX/HPUX/11.00
3. Run the GSM SRM Agent installation script. For example:

./srmAgent-install.sh

The installation script installs and starts the SRM Agent.

Agent Auto Registration on UNIX Servers (non-Solaris)

To configure agent auto registration after installation, you can manually add the SRM
Agent to a Local Manager Routing Agent configuration as a SUB_AGENT entry or add the
required entries to the storability.ini file. Sample storability.ini entries for the SRM Agent
appear below.

GSM_LM HOST = 10.192.1.15
GSM LM PORT = 17146
GSM_ENABLE LM REGISTRATION = true

RED HAT LINUX SRM AGENT INSTALLATION

On Red Hat Linux, the SRM Agent is provided as a simple “Tarball” or zipped tar archive.
To install the agent, simply unpack the “Tarball” (<agent>-rh<version>.tgz) and start
the agent using the startup script (located in /etc/rc.d/init.d on Red Hat servers).

1. Mount the Sun StorageTek Business Analytics Agent Installation CD to cdrom. For
example:

/mount/mnt/cdrom

2. Change directory to the Linux directory:
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/mnt/cdrom/Unix/Linux

[root@Linux]# Is -al

total 10

dr-xr-xr-x 5 root root 2048 Nov 1 03:24 .

dr-xr-xr-x 6 root root 2048 Oct 13 16:47 ..

dr-xr-xr-x 2 root root 2048 Oct 25 00:28 RedHat-7.2

dr-xr-xr-x 2 root  root 2048 Nov 1 03:24 RedHat-EnterpriseEdition
dr-xr-xr-x 2 root root 2048 Oct 25 00:25 Suse-8.0

3. The installation files are listed as follows:

RedHat-7.2: srmAgent-install.sh srmAgent-rh72.tgz
RedHat Enterprise Edition 3.0 or 4.0: srmAgent-install.sh srmAgent-rhee.tgz

4. To install the agent, simply run the installation script srmAgent.sh as shown below.
./srmAgent-install.sh

This script will look for the "Tarball" in its current directory default or in the path
specified as the first argument.

Note: The same installation files are used to support RedHat Edition 3.0 and RedHat
Edition 4.0.

5. Verify the srmAgent started.
6. To start/stop the agent, simply run the startup script as shown below.

etc/rc.d/init.d/srmAgent start
etc/rc.d/init.d/srmAgent stop

VERIFYING SRM AGENT

Use the Sun StorageTek Business Analytics Agent Diagnostic Tool to verify the SRM
Agent functionality. This diagnostic utility is installed as part of the Sun StorageTek
Business Analytics Central Manager or Local Manager Software installation.

1. Wait until after the SRM Agent logs a message that it has completed the filesystem
scan before querying the agent using the Business Analytics Agent Diagnostic Tool.
2. Launch the Business Analytics Agent Diagnostic Tool from its Program Folder.

a. In the Agent location window, enter the IP Address or network resolvable Host
Name of the server where the agent is installed in the ip address/host name
input box.

b. Set the port to 17152 (or select the SRM agent from the drop down list of service
names).

c. Click the Get Object List button and you should receive a list of objects
published by the SRM Agent.

d. Select the gsa_srm_largest_files-2_1 object and it should report the
ip_address, nodename, and hostid of the server.
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Figure 4 - Sample SRM Largest Files Object

e. If you have user-defined files configured, collect the gsa_srm_usage_details
object and examine the “filter_name” field.

f. Verify all other objects published by the agent.

3. Verify the SRM Agent is registered with the configured Local Manager:

a. Enter the IP Address or Hostname of the Local Manager and set the port to
17146 (or select the Routing Agent from the drop down list of service names).

b. Click the Get Object List button and you should receive a list of tables published
by the Routing Agent. If unsuccessful, verify the Ethernet connectivity to the
server running the Sun StorageTek Business Analytics Routing Agent and that the
agent is running.

C. Collect the gsa_agent_register object. Verify:

* An entry is displayed with a port field that is 17152 and a peer_list field that
is the host name/IP Address where the SRM Agent is running.
* The type field displays the expected type of agent registration where:
o AUTO_NET indicates agent auto registration occurred
o STATIC means registration occurred through a SUB_AGENT entry in the
Routing Agent’s storability.ini file.
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VERIFYING MANAGEMENT CONSOLE
FUNCTIONALITY

The following procedure describes how the Sun StorageTek Business Analytics
administrator verifies the SRM Agent’s reports in the Management Console. Refer to the
Administration chapter to obtain information on the administrative menus you can
access from the Tools pull down menu, including the Polling and Change Dashboard
menus.

1. Log in to the Management Console as an administrative user (e.g., gsmuser) whose
views provide access to the desired assets (e.g., sites).

2. Select Tools->Data Polling Schedule. The following step assumes that a polling
schedule exists for SRM for the specific site or all sites. If not, refer to the
Administration chapter and create one before you proceed to the next step.

3. Use the Collect Now button to collect the SRM (collection type) Configuration

(Collection Metric) data using a polling schedule that includes the specific site or all

sites.

Wait a minute or so to allow the data to be collected and inserted into the database.

Repeat Step 3 for the Collection Metric of Statistics.

Wait a minute or so to allow the data to be collected and inserted into the database.

Close the Data Polling Schedule window.

Click Servers->Filesystem Consumers and expand the appropriate view/site in
the navigation pane to locate the target server.

Click the server and verify the Filesystem Consumer Listing report is displayed.

O Nk

Filesystem View

From Date: [11/1/2004 | [0

Sort: (" byOS & bySte Filesystem Listing
Fpr=— C5: Windows NT
“EITESh REport Site: Default Site Anywhere, USA
=
f) Filesystems by Sike Date: [11/1j2004 i Refresh Report
231 Default Sike Arvywhere, USA
g Lin
qﬂ windows MNT Host Name Filesystem Name Type Total Size (MB) Used Size (MB) %o Used r
@l shoga pune advance? E:l MTFS 20,002,773 19,478,828 97,10 % (NN
-&] sunsite pune
advancez [ell} FAT3Z 9,991,594 9,155,477  91.60% [
advance? o8 FAT3Z 2,189,130 6582500 &040% [ 1

m H i H m Page 1 of 1 | Jump ko page; “ |

Figure 5 - Filesystem Listing

10. Click the Filesystem Name link and the Filesystem Details report is displayed.
11. Expand the headings and the different filters are displayed. Verify:

» Distribution of files (file type, file size)

« Specific files (largest files, largest old files, etc.)

A sample Unauthorized Files report appears below.
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Server: advance2
File System: E:,
0S: Windows NT

Last Scan: 11,/1/2004 5:28:15
AM

E--‘ Filesystem Details
(@] Summary

(@] Share

-{@] Space Consumers
E-{@] Directories

fo.. Tempoarary Directaries
El-{@] Distribution of Files
; Filz Type

File Size

E@ Specific Files
Largest. Files
Largest Old Files
Database_Files
Email_srchives

fo Unauthorized_Files

|

-

Unauthorized_Files
File Name i

E:\GSM_4_0_ISOsi4-0-Qa_150504-0-31-
qa'lcrm.iso

E:\G5M_4_0_IS0si4-0-04_1S0514-0-32-
qalCM.iso

EGSM_4_0_IS0si4-0-04_150514-0-32-
qaiLMLULiso

E:\GSM_4_0_I50si4-0-08_150%5\4-0-32-
qa'lLMW.iso
E:\GSM_4_0_ISOsi4-0-Qa_15054-0-32-

QaiMC.iso
E:\GSM_4_0_ISOsi4-0-04_150514-0-33-

qga'crm.iso

E:\@SM_4_0_1S0si4-0-08_I50514-0-33-

qahlmu.iso
E:\GSM_4_0_I50si4-0-08_1505|4-0-33-
qa'lmc.isa
E:\GIM_4_0_I50s14-0-08_I50F\4-0-34-
galCM.iso

Type Owner

iso

BUILTIM} Administratars
BUILTIM} Administratars
BUILTIM} Adrniristrators
BUILTIM} Adrninistrators
BUILTIM} Administratars
BUILTIM} Administratars
BUILTIM} Adrniristrators
BUILTIM} Adrninistrators

BUILTIM} Administrators

Export

Last Modified

10202004 3:36:46
Al

10/21)2004 6:16:12
P

10/21)2004 6113146
P

10/21/2004 6:15:02
Pt
10f21)2004 6:11:04
P
10/26)2004 7:48:26
P
10/26)2004 7152118
P
10f26/2004 7:53:116

Pt

10f29/2004 6:55:33
PM

Filesystem Details

Size
{MB})
206,751
206,751
695,406
357,438
142,906
208,25
360,313

142,938

206,313

Figure 6 - Unauthorized Files Report

SRM AGENT TROUBLESHOOTING

1. Verify system/agent prerequisites - Refer to Sun StorageTek Business Analytics
Support Matrix to verify the most recent support requirements for the agent.

2. Review the Message Log - Review/collect the SRM Agent Message.log file that can
contain information on startup errors, configuration errors, or errors regarding
accessing data (e.g., impersonating user logon failure) or parsing output.

Note: If there is a configuration error, an entry will specify the line number and
other error details and indicate the “default SRM Agent Configuration settings” are

being used.

Verify that a logged entry indicates the Message log file indicates that the agent has
finished the filesystem scan and specifies when the next scheduled filesystem scan is
scheduled before you use the GSM Agent Diagnostic Tool to collect and verify the

SRM Agent published objects.

Windows

+ Located by default in: <drive>:\Program

Files\Storability\GSM\Agents\Storability SRM Agent folder.
* (Can enable debug level logging by appending LOG_SEVERITY=Debug to
the SRM Agent section of the storability.ini file (if your support
representative requests it).

Solaris

* Agents common Message.log file located by default in: /opt/storability/data.
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« Can enable debug level logging by appending LOG_SEVERITY=Debug to the
SRM Agent section of the storability.ini file (if Storability Support requests
it).

3. Verify Local Manager Registration - The configured Local Manager
gsa_agent_register table should be reviewed if the auto-registration feature is
enabled (default). Otherwise, verify the necessary SUB_AGENT entry has been added
to the Routing Agent’s storability.ini file.

4. Review the Routing Agent Message Log - Review/collect the configured Routing
Agent’s Message Log to check for errors related to Ethernet connectivity problems
contacting the Storability SRM Agent.

5. Use the Business Analytics Agent Diagnostic Tool to save the output for all the tables
if escalating a problem to Sun Technical Support.

a. Run the Sun StorageTek Business Analytics Agent Diagnostic Tool (gsmdiag.exe).

b. Enter the IP Address or Hostname of the server where the agent is installed
and set the port to 17152 (or select the SRM agent from the drop down list of
service names).

C. Click the Get Object List button and you should receive a list of tables published
by the SRM Agent. If unsuccessful, verify the Ethernet connectivity to the server
running the SRM Agent and that the SRM Agent is running.

d. Select the alerts-3_1 table and examine the Description column for each
reported alert.

€. Select File->Save All and the “This action will network fetch all objects
published by the currently specified agent and save the data to a single file.”
Message appears.

f. Click OK and the Save As dialog appears.

g. Enter a meaningful file name and click OK to initiate the collection.

h. Enter the desired file name and click OK.

6. Confirm Data Polling Schedules - Using the Management Console’s Data Polling
Schedule menu, review/modify the existing Polling Schedules for the Collection Type
of SRM at all sites.

7. Review Aggregator Message Log - Open the Data Aggregator’s Message Log in a
text editor and validate that the SRM Tables are being requested and that rows are
being inserted into the database.

The log contains two entries, TID (Transaction ID) and SID (Session ID), which can
help you locate (e.g., Find) and view relevant logged entries. For scheduled polling
requests, the TID will be equal to the Job ID in the Data Polling Schedule menu. Each
SID is a unique identifier for a particular agent data collection session. For on-
demand polling requests, the TID is a uniquely generated TID (not the Job ID) and
SID, and the TID and SID will be equal to the same integer value.

8. Check the assurent database - The assurent database is the data repository for
your Sun StorageTek Business Analytics application. For the SRM Agent, use any MS
SQL Query interface, such as isql, to verify rows have been inserted into the SRM-
related tables, such as the gsa_srm_largest_files table.

9. Verify Management Console Functionality - As a final step in the agent
troubleshooting procedure, minimally verify that the File System Consumers and File
System Details reports work properly.
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UPGRADE SRM AGENT — NON SOLARIS UNIX HOST

To upgrade an existing SRM Agent, you perform the following tasks:

1. Stop the SRM Agent (srmAgent):
/etc/rc.d/init.d/srmAgent stop
[root@linux /]# /etc/rc.d/init.d/srmAgent stop
Stopping Storability SRM agent: srmAgent 939 killed
2. Manually remove the storability directory under /opt
rm -rf storability

3. Verify the /opt/storability directory is deleted

REINSTALLING THE SRM AGENT - NON-SOLARIS
UNIX HOsST

The reinstallation procedure for all Sun StorageTek Business Analytics agents supported
on non-Solaris UNIX hosts, such as the Host Agent on an IBM AIX server, requires that
the installer perform the following steps before running the agent’s installation script:

1. Make a backup copy of the existing agent configuration files (storability.ini and
config_srm.xml).

2. Make a backup copy of the contents of /opt/storability/etc/agents.
3. Open the existing agent configuration file (storability.ini) in a system text editor.
4. Locate the configuration section for the agent to be reinstalled.

5. Delete all existing configuration settings for that Sun StorageTek Business Analytics
agent.

6. Save the modified agent configuration file.
7. Remove the existing /opt/storability/etc/agents directory.

At this point, you may reinstall the agent using the agent’s installation script (e.g.,
srmAgent-install.sh).

UNINSTALL SRM AGENT - INSTALLSHIELD

1. Select Start->Program Files->Storability->Uninstall->Uninstall Local
Manager
Or:
Start->Program Files->Storability->Uninstall->Uninstall Host Agent and
Uninstall SRM Agent. The Storability Uninstall dialog appears.

2. Click the checkbox for the Host Agent and/or SRM Agent.

3. Click Next>. The Question dialog appears.
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4. Click Yes to confirm the uninstallation. An uninstalling agent splash box appears as
each selected agent is uninstalled.
5. When the InstallShield Wizard Complete dialog box appears, click Finish.

UNINSTALL SRM AGENT - SOLARIS

The setup script is used to uninstall the SRM Agent installed on a Solaris server. The
installation script (setup) is supplied on the Solaris Local Manager Installation CD.

1. To view a list of installed agents, type:

setup -u
2. Type the number corresponding to the SRM Agent and press Enter.
3. Type zero (0) to end the selection of agents for removal.

4. When prompted, type y and press Enter to confirm the agent removal.

REINSTALLING THE SRM AGENT - NON-SOLARIS
UNIX HOsST

The reinstallation procedure for all Sun StorageTek Business Analytics agents supported
on non-Solaris UNIX hosts, such as the Host Agent on an IBM AIX server, requires that
the installer perform the following steps before running the agent’s installation script:

1. Make a backup copy of the existing agent configuration files (storability.ini and
config_srm.xml).

2. Make a backup copy of the contents of /opt/storability/etc/agents.
3. Open the existing agent configuration file (storability.ini) in a system text editor.
4. Locate the configuration section for the agent to be reinstalled.

5. Delete all existing configuration settings for that Sun StorageTek Business Analytics
agent.

6. Save the modified agent configuration file.
7. Remove the existing /opt/storability/etc/agents directory.

At this point, you may reinstall the agent using the agent’s installation script (e.g.,
srmAgent-install.sh).
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